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Legal disclaimer1

1.1 Legal disclaimer

All products manufactured by FLIR Systems are warranted against defective materials
and workmanship for a period of one (1) year from the delivery date of the original pur-
chase, provided such products have been under normal storage, use and service, and in
accordance with FLIR Systems instruction.

Products which are not manufactured by FLIR Systems but included in systems deliv-
ered by FLIR Systems to the original purchaser, carry the warranty, if any, of the particu-
lar supplier only. FLIR Systems has no responsibility whatsoever for such products.

The warranty extends only to the original purchaser and is not transferable. It is not appli-
cable to any product which has been subjected to misuse, neglect, accident or abnormal
conditions of operation. Expendable parts are excluded from the warranty.

In the case of a defect in a product covered by this warranty the product must not be fur-
ther used in order to prevent additional damage. The purchaser shall promptly report any
defect to FLIR Systems or this warranty will not apply.

FLIR Systems will, at its option, repair or replace any such defective product free of
charge if, upon inspection, it proves to be defective in material or workmanship and pro-
vided that it is returned to FLIR Systems within the said one-year period.

FLIR Systems has no other obligation or liability for defects than those set forth above.

No other warranty is expressed or implied. FLIR Systems specifically disclaims the im-
plied warranties of merchantability and fitness for a particular purpose.

FLIR Systems shall not be liable for any direct, indirect, special, incidental or consequen-
tial loss or damage, whether based on contract, tort or any other legal theory.

This warranty shall be governed by Swedish law.

Any dispute, controversy or claim arising out of or in connection with this warranty, shall
be finally settled by arbitration in accordance with the Rules of the Arbitration Institute of
the Stockholm Chamber of Commerce. The place of arbitration shall be Stockholm. The
language to be used in the arbitral proceedings shall be English.

1.2 Usage statistics

FLIR Systems reserves the right to gather anonymous usage statistics to help maintain
and improve the quality of our software and services.

1.3 Changes to registry

The registry entry HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Lsa
\LmCompatibilityLevel will be automatically changed to level 2 if the FLIR Camera Moni-
tor service detects a FLIR camera connected to the computer with a USB cable. The
modification will only be executed if the camera device implements a remote network
service that supports network logons.

1.4 Copyright

© 2018, FLIR Systems, Inc. All rights reserved worldwide. No parts of the software in-
cluding source code may be reproduced, transmitted, transcribed or translated into any
language or computer language in any form or by any means, electronic, magnetic, opti-
cal, manual or otherwise, without the prior written permission of FLIR Systems.

The documentation must not, in whole or part, be copied, photocopied, reproduced,
translated or transmitted to any electronic medium or machine readable form without pri-
or consent, in writing, from FLIR Systems.

Names and marks appearing on the products herein are either registered trademarks or
trademarks of FLIR Systems and/or its subsidiaries. All other trademarks, trade names
or company names referenced herein are used for identification only and are the prop-
erty of their respective owners.
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Legal disclaimer1

1.5 Quality assurance

The Quality Management System under which these products are developed and manu-
factured has been certified in accordance with the ISO 9001 standard.

FLIR Systems is committed to a policy of continuous development; therefore we reserve
the right to make changes and improvements on any of the products without prior notice.
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Notice to user2

2.1 Training
To read about infrared training, visit:

• http://www.infraredtraining.com
• http://www.irtraining.com
• http://www.irtraining.eu

2.2 Documentation updates
Our manuals are updated several times per year, and we also issue product-critical notifi-
cations of changes on a regular basis.

To access the latest manuals, translations of manuals, and notifications, go to the Down-
load tab at:

http://support.flir.com

It only takes a few minutes to register online. In the download area you will also find the
latest releases of manuals for our other products, as well as manuals for our historical
and obsolete products.
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Customer help3

3.1 General
For customer help, visit:

http://support.flir.com

3.2 Submitting a question
To submit a question to the customer help team, you must be a registered user. It only
takes a few minutes to register online. If you only want to search the knowledgebase for
existing questions and answers, you do not need to be a registered user.

When you want to submit a question, make sure that you have the following information
to hand:

• The camera model
• The camera serial number
• The communication protocol, or method, between the camera and your device (for ex-

ample, SD card reader, HDMI, Ethernet, USB, or FireWire)
• Device type (PC/Mac/iPhone/iPad/Android device, etc.)
• Version of any programs from FLIR Systems
• Full name, publication number, and revision number of the manual

3.3 Downloads
On the customer help site you can also download the following, when applicable for the
product:

• Firmware updates for your infrared camera.
• Program updates for your PC/Mac software.
• Freeware and evaluation versions of PC/Mac software.
• User documentation for current, obsolete, and historical products.
• Mechanical drawings (in *.dxf and *.pdf format).
• Cad data models (in *.stp format).
• Application stories.
• Technical datasheets.
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Installation4

4.1 General information
4.1.1 Explanation

The following programs are included on the ThermoVision System Tools & Utilities CD
(the programs can also be downloaded from the Downloads tab at
http://support.flir.com):

• FLIR IP Config
A setup and configuration program for detecting and finding FLIR automation and sci-
ence cameras on a network and automatically assigning or manually setting IP
addresses.

• FLIR IR Monitor
A program for controlling FLIR automation and science cameras on a network. You
typically use FLIR IR Monitor to change camera settings, lay out measurement tools
on the screen, set up alarms, etc.

• FLIR IR Camera Player
A PC-based remote control and video player for infrared cameras from FLIR Systems.

• A link to a web installation of FLIR Axxx Control & Image Interfaces
An installation that includes Interface Control Documents (ICDs), user documentation,
and C-code examples. We recommend that you read through the documentation.

4.1.2 Default installation paths

• C:\Program Files\FLIR Systems\FLIR IP Config
• C:\Program Files\FLIR Systems\FLIR IR Monitor
• C:\Program Files\FLIR Systems\FLIR IR Camera Player
• C:\Program Files\FLIR Systems\FLIR Axxx Control & Image Interfaces

Note Functionality in the PC programs is dependent on the camera model.

4.2 System requirements
4.2.1 Operating system

• Microsoft Windows 10, 32-bit and 64-bit.
• Microsoft Windows 7, 32-bit and 64-bit.

4.2.2 Hardware

• Personal computer with a 2 GHz 32-bit or 64-bit processor.
• 1 GB of RAM or more.
• 20 GB of hard disk space.
• Super VGA (1024 × 768) or higher-resolution monitor.
• Support for DirectX 9 graphics with:

◦ WDDM driver
◦ 128 MB of graphics memory (minimum)
◦ Pixel Shader 2.0 (in hardware)
◦ 32 bits per pixel.

• DVD-ROM drive.
• Audio output.
• Keyboard and Microsoft mouse, or a compatible pointing device.

4.2.3 Software

• Google Chrome version 70 or higher (recommended).
• Microsoft Internet Explorer 11 or higher.
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Installation4

4.3 Installation
4.3.1 General

Important information can be found in the read-me file on the installation CD. We recom-
mend that you read that file before you start the installation.

The installation files can also be downloaded from the Downloads tab at
http://support.flir.com.

Note

• If you experience problems during the installation, visit our Customer Help at http://
support.flir.com.

• You must be an Adminstrator or a user with Administrative Rights to install the
programs.

• A complete installation consists of several subinstallations, some of which are from
third-party vendors. Do not abort these subinstallations, as they are needed for the
complete installation.

• A complete installation can take up to 10 minutes to complete.

4.3.2 Install from CD

Follow this procedure:

1. Close down all applications.
2. Insert the ThermoVision System Tools & Utilities CD into the CD drive of the

computer.
The installation should start automatically. If not, start Windows File Explorer and
double-click SETUP.HTM on the CD.

3. Click Install FLIR IP Config.
4. Follow the on-screen instructions.

4.3.3 Install from downloaded files

Follow this procedure:

1. Close down all applications.
2. Download the FLIR IP Config installation zip file from the Downloads tab at

http://support.flir.com.
3. Extract the installation zip file.
4. To start the installation, double-click the executable file (.exe).
5. Follow the on-screen instructions.
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Detecting cameras in a network5

5.1 General
With FLIR IP Config, you can do the following:

• Automatically assign or manually set the IP address for a camera.
• Set the subnet mask for a camera.
• Set the default gateway for a camera.
• Go to the camera’s web interface (dependent on the camera model). For more infor-

mation, refer to the user’s manual of your camera.

5.2 Modifying IPAddress settings
Follow this procedure:

1. On the Start menu, click FLIR IP Config (Start > Programs > FLIR Systems > FLIR IP
Config). This will display the FLIR IP Config main window:

2. In the list of detected cameras, do the following:

• Right-click one camera and selectModify.

• Select one camera and click on the toolbar.
This will display the IPAddress Settings dialog box:

3. In the IPAddress Settings dialog box, you can enter new values for one or more of
the following parameters:

• IP address.
• Subnet mask.
• Default gateway.

4. Click OK.

#T559494; r. AC/54394/54394; en-US 7



Detecting cameras in a network5

Note

• A network switch may have the spanning tree algorithm (STA) enabled. The STA
blocks all packets from a new connected port for a “forward delay” second. This for-
ward delay is usually between 15 and 45 seconds. A GigE Vision device complying
with the GigE Vision standard will attempt for only 6 seconds (±2 seconds) to get its
IP address through DHCP before using the local link address (LLA = 169.254.x.x) to
get its IP address. The DHCP process for a GigE Vision-compliant device may there-
fore fail if connected to a switch which has STA enabled. To prevent this from happen-
ing, the forward delay should be set to 4 seconds, or the STA disabled for the switch
port.

• If you change the IP address, you need to restart the camera (dependent on the cam-
era model).

5.3 Changing the language
Follow this procedure:

1. On the Start menu, click FLIR IP Config (Start > Programs > FLIR Systems > FLIR IP
Config).

2. On the main menu bar, click Options. This will display the Options dialog box:

3. To change the language, select a new language in the Language box.
4. Click OK.
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Program reference section6

6.1 Main menu bar
Table 6.1 The File menu

Exit By clicking Exit, the program closes down.

Table 6.2 The Tools menu

Options By clicking Options, the Options dialog box will be
displayed. In this dialog box the language can be
changed.

Table 6.3 The Help menu

Manual as HTML Help By clickingManual as HTML Help, the user docu-
mentation will be displayed as a Microsoft HTML
help file.

Manual as Adobe PDF file By clickingManual as Adobe PDF file, the user
documentation will be displayed as an Adobe
Acrobat PDF file.

6.2 Main toolbar
Table 6.4 The main toolbar

By clicking this toolbar button, a dialog box will be
displayed where the IP address, the subnet mask,
and the default gateway can be changed. The IP
address can also be obtained automatically.

By clicking this toolbar button, the camera’s web
interface will be displayed (dependent on the
camera model).

By clicking this toolbar button, the list of cameras
will be refreshed.
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Program reference section6

6.3 Right-click menu
Table 6.5 The right-click menu

Modify By clickingModify, a dialog box will be displayed
where the IP address, the subnet mask, and the
default gateway can be changed.

Web By clickingWeb, the camera’s web interface will
be displayed (dependent on the camera model).

Refresh By clicking Refresh, the list of cameras will be
refreshed.
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Network troubleshooting7

Try one of the following if you experience network problems:

• Reset the router and unplug and replug the Ethernet cable at both ends.
• Reboot the computer with the cables connected.
• Swap your Ethernet cable with another cable that is either brand new or known to be

in working condition.
• Connect your Ethernet cable to a different wall socket. If you are still not able to get

online, you are probably experiencing a configuration issue.
• Verify your IP address.
• Disable network bridging.
• Disable your Wi-Fi connectivity (if you use it) to ensure that the wired Ethernet port is

open.
• Renew the DHCP license.
• Make sure that the firewall is turned off when you troubleshoot.
• Make sure that your wireless adapter is switched off. If not, the search for the camera

might only look for a wireless connection.
• Normally a computer will handle both crossed and uncrossed cable types automati-

cally, but for troubleshooting purposes try both or use a switch.
• Turn off any network adapters that are not connected to the camera.
• For troubleshooting purposes, power both the camera and the computer using a

mains adapter. Some laptops turn off the network card to save power when using the
battery.

If none of these steps help you, contact FLIR Customer support at http://support.flir.com.
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About FLIR Systems8

FLIR Systems was established in 1978 to pioneer the development of high-performance
infrared imaging systems, and is the world leader in the design, manufacture, and mar-
keting of thermal imaging systems for a wide variety of commercial, industrial, and gov-
ernment applications. Today, FLIR Systems embraces five major companies with
outstanding achievements in infrared technology since 1958—the Swedish AGEMA In-
frared Systems (formerly AGA Infrared Systems), the three United States companies In-
digo Systems, FSI, and Inframetrics, and the French company Cedip.

Since 2007, FLIR Systems has acquired several companies with world-leading expertise
in sensor technologies:

• Extech Instruments (2007)
• Ifara Tecnologías (2008)
• Salvador Imaging (2009)
• OmniTech Partners (2009)
• Directed Perception (2009)
• Raymarine (2010)
• ICx Technologies (2010)
• TackTick Marine Digital Instruments (2011)
• Aerius Photonics (2011)
• Lorex Technology (2012)
• Traficon (2012)
• MARSS (2013)
• DigitalOptics micro-optics business (2013)
• DVTEL (2015)
• Point Grey Research (2016)
• Prox Dynamics (2016)

Figure 8.1 Patent documents from the early 1960s

FLIR Systems has three manufacturing plants in the United States (Portland, OR, Boston,
MA, Santa Barbara, CA) and one in Sweden (Stockholm). Since 2007 there is also a
manufacturing plant in Tallinn, Estonia. Direct sales offices in Belgium, Brazil, China,
France, Germany, Great Britain, Hong Kong, Italy, Japan, Korea, Sweden, and the USA
—together with a worldwide network of agents and distributors—support our internation-
al customer base.
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About FLIR Systems8

FLIR Systems is at the forefront of innovation in the infrared camera industry. We antici-
pate market demand by constantly improving our existing cameras and developing new
ones. The company has set milestones in product design and development such as the
introduction of the first battery-operated portable camera for industrial inspections, and
the first uncooled infrared camera, to mention just two innovations.

Figure 8.2 1969: Thermovision Model 661. The
camera weighed approximately 25 kg (55 lb.), the
oscilloscope 20 kg (44 lb.), and the tripod 15 kg
(33 lb.). The operator also needed a 220 VAC
generator set, and a 10 L (2.6 US gallon) jar with
liquid nitrogen. To the left of the oscilloscope the
Polaroid attachment (6 kg (13 lb.)) can be seen.

Figure 8.3 2015: FLIR One, an accessory to
iPhone and Android mobile phones. Weight: 90 g
(3.2 oz.).

FLIR Systems manufactures all vital mechanical and electronic components of the cam-
era systems itself. From detector design and manufacturing, to lenses and system elec-
tronics, to final testing and calibration, all production steps are carried out and
supervised by our own engineers. The in-depth expertise of these infrared specialists en-
sures the accuracy and reliability of all vital components that are assembled into your in-
frared camera.

8.1 More than just an infrared camera
At FLIR Systems we recognize that our job is to go beyond just producing the best infra-
red camera systems. We are committed to enabling all users of our infrared camera sys-
tems to work more productively by providing them with the most powerful camera–
software combination. Especially tailored software for predictive maintenance, R & D,
and process monitoring is developed in-house. Most software is available in a wide varie-
ty of languages.

We support all our infrared cameras with a wide variety of accessories to adapt your
equipment to the most demanding infrared applications.

8.2 Sharing our knowledge
Although our cameras are designed to be very user-friendly, there is a lot more to ther-
mography than just knowing how to handle a camera. Therefore, FLIR Systems has
founded the Infrared Training Center (ITC), a separate business unit, that provides certi-
fied training courses. Attending one of the ITC courses will give you a truly hands-on
learning experience.

The staff of the ITC are also there to provide you with any application support you may
need in putting infrared theory into practice.
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About FLIR Systems8

8.3 Supporting our customers
FLIR Systems operates a worldwide service network to keep your camera running at all
times. If you discover a problem with your camera, local service centers have all the
equipment and expertise to solve it within the shortest possible time. Therefore, there is
no need to send your camera to the other side of the world or to talk to someone who
does not speak your language.
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